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DANGER /\ Please comply with these notices, incorrect handling may cause system
4 working incorrect or abnormal. Severely, may result in property damage.

This device and its components may only be used for the applications

CAUTION described in the catalog or the technical descriptions, and only in

connection with devices or components from other manufacturers which
have been approved or recommended by Thinget.

This product can only function correctly and safely if it is transported,
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recommended.
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Since deviations cannot be precluded entirely, we cannot guarantee full agreement. This manual is
subject to change without notice.
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Preface

. PREFACE —Essential introduction about this manual I

Thank you for buying TP series touch screen made by Thinget Electronic Co.,Lt ,this manual should

be read and understood before attempting relevant operation.

Purpose of this manual

*  This manual offers guidance and information about how to use TP correctly and maintenance,

including application situations, operations, transportation, storage, installation, maintenance, etc.
* This manual mainly contains four parts: hardware, software, application and appendix.

> Hardware Parts: Describing the essential features, specifications, dimensions, installations
and communication connecting of TP series.

» Software Parts: Introducing how to use graphics software TouchWin2.7 and connect it with
TP.

> Application Parts: Illustrating how to use TP with practical cases to make user understand
deeply.

» Appendix Parts: Introducing the connection methods between TP and other popular types of
PLC.

Qualified Personnel

This manual is intent for the following personnel:

= Terminal Users
. Debug Engineers
= Technique Supporters

Please read and understand the safety precautions very carefully before operating or debugging.

Validity of the Manual

This manual may only be used for TP series touch screen and its graphic software made by Thinget.

Electronic Documents

In addition to our written manuals, we offer electronic documentations of our products by the

following ways.

- User CD

There are software, user manual and application tip of relevant products.
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. Website
Please visit Thinget Electronic Co.,Ltd. at www.thinget.com to obtain all variable electronic
documents.

Contact I

Welcome to contact us if you have any problem.

Tel: 0510-85134136 85123803

Fax: 0510-85111290

Address: 4th Floor Building 7, Orignality Industry Park, LiYuan Development Zone, Wuxi
City, Jiangsu Province 214072






Safety Precautions

SAFTY PRECAUTIONS -- Essential introduction about product operation

Please read this manual very carefully before operation and please operate correctly while paying
close attention to all the safety points. The following contents only used for TP series touch screen.
Please keep this manual properly, place it where can be read easy for the operators and make sure

hand it to terminal user.

Notice Items

Notice

@ Please do not bind power line and communication cable together or let them too close, keep at
least 10 cm distances between them.

@ Please do not install experimental module or refit wiring. Otherwise it may cause malfunction,

error action, damage or fire.

@ Please shut off the power when there is abnormal smell or voice with TP products. (The
briefness call made by buzzer after electrifying is normal)

@ Please do not strike the touch panel with a hard or pointed object, or press on the touch panel
with too much force or with pen, screw, since these may damage the touch panel and cause
malfunction.

@ Please tighten the screws while installation. If these screws are not tightened firmly, it may
cause short-circuit, fire, or malfunction.

@ Please transport, store, set up, installed and maintain the product correctly, otherwise it may

damage the touch panel.

/\ Danger

@ Please be sure the TP's rated voltage is within the designated range, and that the power terminal

lines are correctly attached. Otherwise, it may cause damage.

@ Please do not touch terminals when power on to avoid causing an electric shock.

@ Please do not open the cover board.

@ Please cut off all the power while installing or disassembling TP products, otherwise it may
cause misoperation and malfunction.

@ Please use TP series touch screen in the certain environmental conditions according to this
manual , it may cause accident.

@ Please do not use the products in the environment with high frequency radiation, high magnetic

field or other interferences.



Hardware Parts

HARDWARE PARTS-- Features, Specifications, Dimensions and Application

notes of TP series touch screen

1. Product Overview

2. General Specifications

3. Parts Description

4. External Dimension

5. Installing Method

6. Port Instruction

7. Daily Maintenance and Cleaning







Hardware Parts

1 PRODUCT OVERVIEW

= Summary of products

TP series touch screen is a device connecting with PLC, inverter and other control devices to carry out
digital display, monitor, switch control and other operations. With visual menu, good compatibility, high

performance-price ratio, they have been the optimal choice of middle and small size control system.

According to product’s sizes, operation modes, there are models in the following table:

Display Size Display Material TP Series
4.7 Inch Blue-white LCD TP460-L
Blue-white LCD TP560-L TP560-G
5.7 Inch
256-Color TP560-T TP561-T
7.0 Inch 256-Color TP760-T
Black-white LCD TPA60-L
10.4 Inch
256-Color TPA60-T TPA61-T

All the models’ working voltage in the above table is DC24V unless otherwise special noted.
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1-1. Features

Thinget TP series touch screen contain products with various dimensions and functions as shown below.
Moreover, user friendly graphic editor supporting simulate on line/off line and configuration function will
make mastery easier for your control system.

Display

Various models: product size from 4.7 to 10.4”

Abundant displays: Blue-white LCD, 4 bits grey scale, 16 bits grey scale, 256-color, support BMP format
with vivid screen.

Multiplicate languages: English, Chinese, Japanese, Korean and so on with font setting freely.

Expanding capacity: Add more screens and data

Control

Controlling dynamic digital display and monitor, bar graphics, real trend map, discrete/continues map and
switch.

Alarming at real time and record history alarm

Picking up data with timer or setting condition

Setting three grades password limitation

Supporting simulate on line /off line and configuration function which can simulate operations without
connecting TP.

Communication

Double-ports communication separately which can connect two different devices simultaneously.
Driving panel printer directly and make the process low cost and flexible.
Supporting freedom protocol and drive program compiled by end-users.
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1-2. Workflow

The main operating steps of TP series touch screen are shown in the following figure:

Installing TP software in PC

v

Editing project graphics in TP software

l

'

|

Simulating TP action in
graphics software and
observing the effect.

Electrifying TP and connecting PC and TP

l

Downloading project data to TP

l

B Simulate on line
Connecting PC and PLC
with cable and then
simulating TP action in
PC.

Electrifying PLC and connecting TP and PLC

l

Communicating TP with PLC
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2 GENERAL SPECIFICATION

TP460 series
Item TP460
Input Voltage DC20-DC28V
) Current Consumption < 180mA
Electrical Allowable Momentary Less than 20ms
Features Power-cut
Voltage Endurance AC1000V-10mA 1 minute (signal and time)
Insulated Resistance DC500V-About 10M @ (signal and time)
i Communication Port Support RS-232/RS-422/RS-485
Download Port Support RS-232
Operating Temperature 0—607C
Storage Temperature -20-60°C
Ambient Humidity 20-85% (Non condensing, dry bulb)
Vibration Resistance 10-25HZ (X, Y, Z direction for 30 minutes 2G)
Environment . . .
Interference Rejection Noise voltage: 1000Vp-p. pulse duration lus. 1
minute
Surrounding Atmosphere free of corrosive gasses
Protect Configuration Accord with IP65
Type Monochrome
Using Life 50000 hours upwards, environmental temperature 25
‘C, 24hours running
Screen Display Area 240*128
Lighteness Contrast Adjustable (by regulation resistance)
properties Language setting English, Chinese, Japanese, Korean
and others
Character dimension Discretional font, Discretional dimension
Touch panel Matrix type touch
Memorizer Screen MB
Data 1KB
Cooling Manner Natural air cooling
Configuratio External Dimensions(mm) 173.2*121.4*45
n Cutout Dimensions 164*112

(For front panel) (mm)
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TP560/561 series

Model
TP560-L TP560-G TP560-T TP561-T
Item
Input Voltage DC20-DC28V
Current <240mA <240mA <280mA <280mA
. Consumption
Electrical Allowable Less than 20ms
Features Momentary
Power-cut
Voltage Endurance AC1000V-10mA 1 minute (signal and time)
Insulated Resistance DC500V-About 10M @ (signal and time )
Port Communication Port Support RS-232/RS-422/RS-485
Download Port Support RS-232
Operating 0—50C
Temperature
Storage Temperature -20-60°C
Ambient Humidity 20-85% (Non condensing, dry bulb)
Environmen Vibration Resistance 10-25HZ (X, Y, Z direction for 30 minutes 2G)
¢ Interference Noise voltage: 1000Vp-p. pulse duration lus. 1 minute
Rejection
Surrounding Free of corrosive gasses
Atmosphere
Protect Accord with IP65
Configuration
Type CCFL 16 rank TFT TFT
monochrome grey color 256-color 256-color
Screen Size 5.7 Inch 5.6 Inch
Using Life 50000 hours upwards, environmental temperature 25 °C,
24hours running
Screen Display Area 320%240 320%234
et Contrast Adjustable (by regulation Can not adjust
resistance)
Language Setting English, Chinese, Japanese, Korean
and others
Character Size Discretional font, Discretional dimension
Touch Panel Digital matrix touch
Memorizer Screen MB
Data 2KB | 4KB
Cooling Manner Natural air cooling
External
. . . 200.0*148.0*44.4(mm)
Configurati Dimension(mm)
on Cutout Dimensions 182.4*134.4(mm)

(For front

(mm)

panel)
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TP760 series
Model
TP760-T
Item
Input Voltage DC20-DC28V
Current Consumption 280mA
. Allowable Momentary Less than 10ms
Electrical
Power-cut
F Voltage Endurance AC1000V-10mA 1 minute (signal and time)
eatures
Insulated DC500V-About 10M @ (signal and time)
Resistance
i Communication Port Support RS-232/RS-422/RS-485
0
Download Port Support RS-232
Operating Temperature 0—507C
Storage Temperature -20-60°C
Ambient Humidity 20-85% (Non condensing, dry bulb)
Environment Vibration Resistance 10-25HZ (X, Y, Z direction for 30 minutes 2G)
Interference Rejection Noise voltage: 1000Vp-p~ pulse duration lus. 1 minute
Surrounding Atmosphere Free of corrosive gasses
Protect Configuration Accord with IP65
Type TFT 256-color LCD
Screen Size 7 Inch
Using Life 50000 hours upwards, environmental temperature 25°C,
< 24hours running
creett Display Area 480%234
. Contrast Can not adjust
properties
Language Setting English, Chinese, Japanese, Korean
and others
Character Dimension Discretional font, Discretional dimension
Touch Panel resistance touch
. Screen 4MB
Memorizer
Data 4KB
Cooling Manner Natural air cooling
. External
Configuratio ] ) 200.0*%148.0*44 .4
Dimension(mm)
n

Cutout Dimension

(For front panel) (mm)

182.4*%134.4
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TPA60/A61
Model
TPA60-L TPA60-T TPA61-T
Item
Input Voltage DC20-DC28V
Current 380mA
. Consumption
Electrical Allowable Less than 10ms
Features Momentary
Power-cut
Voltage Endurance AC1000V-10mA 1 minute (signal and time)
Insulated Resistance DC500V-About 10M @ (signal and time
i Communication Port Support RS-232/RS-422/RS-485
Download Port Support RS-232
Operating 0—50C
Temperature
Storage Temperature -20-60°C
Ambient Humidity 20-85% (Non condensing, dry bulb)
Environme Vibration Resistance 10-25HZ (X, Y, Z direction for 30 minutes 2G)
- Interference Noise voltage: 1000Vp-p.pulse duration lus. 1 minute
Rejection
Surrounding Free of corrosive gasses
Atmosphere
Protect Accord with IP65
Configuration
Type 4 bits grey scale TFT TFT
black-white 256-color 256-color
monochrome LCD LCD
Screen Size 10.4 Inch
Using Life 50000 hours upwards, environmental temperature 25
Screen C, 24hours running
i Display Area 640*480 800*640 640*480
Contrast Can not adjust
Language setting English, Chinese, Japanese, Korean
and others
Character dimension Discretional font, Discretional dimension
Touch Panel Resistance
Memorizer Screen SMB
Data 4KB
Cooling Manner Natural air cooling
External
Configurati Dimension(mm) 3117234748
on Cutout Dimension 301*224

(For front

(mm)

panel)
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3 COMPONENT NAMES

TP460-L:

Front View

Rear View

Power
outlet

wrouchifvin

Touch

Area

i

Teuchin Tauch Pancel

TYFE: TP4E0-L
INFUT: DC24% SH
20041130111 6

JLGEGE

Port

2% 0¥ Dovenload MG
7L_l [ J LI R W | J 1T 1
3 N &
/ 1\
Download Communication
Port
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TP560/561 Series:

Front View

Rear View

Touch
Area

WrouchWin

TenstdiWiin Towk Pl

TYPE, TPEEOL

INPUT LY Y

0L Y 1

\
1\

T N—

Power Input

Termimanl Block

Communication
Port

/ﬁ)ownload Portj
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TP760-T:
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TPA60/A61 Series:

Front View
=
Touch
Area
Rear View
]
i [ —— - [ - [ - Ti
[ -] o [ o
O [ - O
[ - [ - oo
i
[ e — -
I
il
O I
O I
| -
OO I
[ -
pEEE T e e ‘
il
[ e — -
O I
i
[ -
| -
O]
[ e e e -
[ e e — -
| -
il O T rT]
[ e - [ -
[ -
———— — — — — — _— ] o [ e -
il O O]
O [ O
ot cad
= & W |_
Input
erminal Block J
Download Port
Communication

Port




Hardware Parts

4 EXTERNAL DIMENSIONS

TP460-L Dimension

TP460-L Actual dimensions (Unit: mm): 163.2X111.4X45

Cutout dimensions (Unit: mm): 165X113

— 165

7
—
/
TP560/561 Dimension
TP560/561 Actual dimensions (Unit: mm): 200.0X 148.0X44.4
Cutout dimensions (Unit: mm): 182.4X134.4
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TP760-T Dimension

TP760-T Actual dimensions (Unit: mm): 200.0 X 148.0X44.4

Cutout dimensions (Unit: mm): 182.4X134.4
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TPA60/61 Dimension

TPA60/A61 Actual dimensions (Unit: mm): 311X234X48

Cutout dimensions (Unit: mm): 301X224
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S INSTALLATION METHOD

When you buy a TP, there will be 4 iron install racks with it. There are two square fix holes on the display’s
upside and downside. Use the mounting bracket to fasten the display tightly in the control tank’s install

holes.

For Touch screen’s temperature will go high if it works too long, be Sure to install the touch screen at least

10cm away from adjacent structures and other equipments (each side Scm) to keep cross-ventilation.

lﬂcm‘
k.

Scm Gem

4 L

:10cm

Installation Panel Mounting Bracket

rw-_:h
e Refer to hereinbefore graph’s size. Open an square hole on the control tank’s panel.

Step2| Add airproof circles in the airproof trough while installing.
Step3| Insert the TP into the cut out of the control tank.

Step4| Set the mounting bracket into the display’s side fixing hole and tight the screw.

Step5| Connect the display and PLC communication ports with cables.

The communication cable can be offered by the supplier or made by user according to the
connecting graphics, give +24V DC power to start working.
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6 PORT INSTRUCTION

Pin assignments of TP series touch screen communication port:

TP Communication Port TP Download Port
PIN # Signal Name PIN # Signal Name
1 TD+ 1 NC
2 RXD1 2 RXD2
3 TXD1 3 TXD2
4 Al 4 A2
5 GND 5 GND
6 TD- 6 BUSY
7 Bl 7 B2
8 RDD- 8 DOWN
9 RDD+ 9 NC
Wiring diagram of TP series touch screen download cable:

PIN # Signal Name PIN # Signal Name

1 NC 1

2 RD2 >< 2 R

3 TXD2 3 THD

4 Al 4

i) 5 GHD 5 GHD

f BUSY i

7 Bl 7 RT3

] NC E

a NC 0
TF Drowenload Port PC’s COM Port

1)On the base of above download cable, jump out the eighth pin and fifth pin, then you can download TP

with force.

2) Please refer to appendix about communication wiring between TP series touch screen and other

mainstream PLC.
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7 REGULAR MAINTANCE AND CLEANING

= Please do not open the rear board by yourself.

= Please do not analyze or rebuild TP series products by yourself

= Please cut off all the power supply while checking.

= Please do not touch terminals in the electriferous products, otherwise, it may cause electric shock.

= Please do not insert or pull out cables with power on or draw the cables while communicating .otherwise,
it may cause damage of the cables.

= Please periodically check installation and screws to avoid falling off.
= Please use TP series touch screen in the certain environment conditions according to this manual
= Please keep the product film clean as to keep it delicacy.

= Please clean the products with clean cloths and appropriate amount of detergent

Cleaning

= Please use clean cloths to clean the screen.

= Please use cloths with appropriate amount of detergent or alcohol while cleaning.
= Natural detergent, without acid, alkali is recommended.

= Keep distance from thrill or strong corrosive gas

= Never spray the detergent directly onto the screen.

= Please do not touch the screen too hard while wiping. otherwise, it will destroy the screen.

Disposal

= Dispose of the product as industrial waste when it comes into castoff.
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SOFTWARE PARTS-Application of TP series touch screen editor software

1. About Graphics Software

2. Getting Started

3. Introducing Menu

4. Making Graphics

5. Basic Components

6. Special Components—Display

7. Alarm Window

8. Print Window

9. Simulate Functions

10. Special Functions
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1 GRAPHICS SOFTWARE

This chapter describes TP series touch screen software’s project screen and its components, and the
components of toolbox, template in addition.

1-1. Installing The Software

1. Operating System: Windows98/2000/XP/ME

2. Installing screen editor software as follows

Double-click “setup.exe” from installation file

dL

Click “next” or “yes” all along until ‘

user information dialog box appears.

il

Input user name, company name and serial number.

The serial number is : Thinget TouchWin (note if the letter is incapital or not and the
blank) , then click “next”

& Setup - TouchWin

User Information

iter your information.

Lizer Mame:

Crganization:

Serial Mumber:

22
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il

Select the target file for software installation, the default address is: “C:\Program
Files\THINGET\TouchWin”

et

ect & different folder

Click “next” all along until completing installation
and then click “finish”.

1L

After installation, the following

icon will appear on the desktop.

23
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1-2. Components Of The Software Screen

Run “TouchWin Edit Tool” from “Start>All Programs> TouchWin” or double-click TP icon on the desktop.

Then, Create a new project and you can see the interface as the following figure:

Menu

B TouchWin Edit Tool - Project - Sc reent

File Edit Yiew Part Tool ‘Window Help
2 e e R Standard Toolbar
B"ﬁ Praject - Screent )
= Screen Lo EEEE bim BN RO R
E Screent 2 Tehnirmce mpmrawe Scissrssce mosrscs Spmsrsice mibd

LGN DEOR OO BeON Beal i L Standard =
| e Part Toolbar

"""""""""" PAGL QGO EEE K @1 I & FHD &«

— = Graphics Toolbar

NThvOooowOE | &
Panel Toolbar
3]

iB %
= [0l o2 | = = 22] Align Toolbar
Zoom ]

©100% - @ i

Status FXI

Zoom Toolbar
Status Toolbar

Operate Toolbar

| [TP760-T  |PLC Port:Thinget #C Series [Download Port:Thinget ¥C Series i 3% 60 | [NUM |

Screen Edit Area

Project Manager

Note: This manual only introduce the elementary functions of the software. Please refer to other
manuals about the advanced functions.
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2 GETTING STARTED

Before you editing TouchWin program, make sure touch screen and PLC models which are the
precondition to decide whether the software could download and communicate normally.

2-1. Creating A New Project

1) Click “New” icon in the standard toolbar or click “New” under “File” menu,as shown below:

%! TouchWin Edit Tool -
Edit Park

Taal

Vig

Standard
5

D + 28 %

ey keI
Qpen... Chrl+0

2) When you create a new project, a pop up dialog box as shown below will appear. Select touch screen
model and then click “Next”.

Select Panel

=-¢3} TPBO Series Touch Panel

[ﬂﬁ OPED Series Dperate Panel
[ﬂ---ﬁ PC HMI Saftware

Attr 4807234, 256 colorz

< Back (] MHewt » > Einizhi Caricel

1L
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3) In the following figure, you can choose port PLC device with default settings of communication
parameters. If you want to modify these parameters, click “Setting...” to open its dialog box.

Pleaze zelect port PLC device:
Thinget XC Seriesz

[

Thinget FC Series
Mitzuibizhi B4 Series
Orraon CPMACOM Senes
Ormron CP1H Series [
Siemens 57-200 Senes T
Siemens 57-300/400

k.opo S Series

Schreider [Micro/Meza/Twido)
kd atzuzhita [FPOFFT)

LS Maszter-k. CPU Direct

LS kaster-k. CHet

Facon (MU Ada]

<

Com Para: 9600, 8, Odd, 1

¢ Back @ Fimzh Cancel

4) Set communication parameters in the following figure and click “ok” to confirm. Then click
“Next” to enter download port setting.

Communication Parameter

~Baudrate—————— [ Data Bit
4800 38400 { FRits  {* SRits

............ - Stop Bit
19200 187800 * 1Bt  ZBits

— Parity check.
" MNone & QOdd " Ewen

— W ait

LCommunication Time I 1] MSEL
W SendData [ “irStation  Betry limes I3

Cancel |

26



Software Parts

1l

5) Set COM parameters of download device, please refer to above method.

Thinge
Mitzubizhi B Senes

Orraon CPMACOM Senes
CQrmron CF1H Series

Siemenz 57-200 Senes
Siemens 57-300/400

F.opo S Seriez

Schheider [Mizro/Meza/ Twido]
kd atzuzhita [FPOAFPT]

LS Master-k. CPU Direct

LS kaster-k CHet i

Com Para: 19200, 8, Even, 1

Setting... |
< Back GD Finizh Caricel
-\-\_\_\_\_'_,_,_:-""

gt

6) After setting, click “ok” to confirm and then click “Next” to continue.
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Communication Parameter

~Baudrate ———————— ~DataBit
4800 33400 " TBits (¢ BBits
lr"asnu 115200 ~ Stap Bit
& 9200 ¢ 187500 @ 1Bt " 2Bits

— Parity check
" Mone i Odd % Even

— WS ait

LCommunication Time | 1] MSEL
I¥ SendData [ WirStation  Fetry times |3

Cancel |

1l

7) Edit name, author and remark as shown in the following below:

Project

Author

Bermark:,
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8) The edit window is shown below:

i L W Pt Vool e el

0 B Y AQU TSI BEEE TE " @ar [ &S Fo & o ki
AhOoCoeDE LW ROd ¢ AR08 Ak amN 4w
| S s @ h s Y QR Ted
Al Amme T iniicn2REHON0ELE Bk TE acl— o 850w
Pl eI ¥ A bN 20 =
ﬂﬁm
Sermatil
et v
Pt darem
Se1E
Pt rew
e
e,
& [
o
Py

L. e : B AEaw

1l

9) Select “Save” In the “File” menu or click “ E ” in the standard toolbar to save your project ,as shown

below

Save jn; I@ Desktop j &= 0y E-

@My Documents

a My Computer
‘3[‘-‘13-' Metwork Places
aMew Folder

File name:

Save

Save astpe: | TouchWwinProject File[™ twp] | Cancel |

d

You can choose where to save files, the auto definition suffix is “.twp”
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2-2. Editing Project

2-2-1 Basic operation of editing screens and windows
2-2-1-1 Creating a new screen or a window

= Creating new screens
1)There are two ways to create a new screen:
Way A
I. Click “screen” in the project manager to make it turn to highlight color.

IL Click k= in the operate toolbar, as shown below.

! Tawe hWin Edit Tool - Project - Screend
Fia Elt Viow Parl Tool Wirdew Heip

D E LE R AGL ’EH:-I EEm R a_ e -
1= ‘\:IGGOGHE hR@E %o “nrn_ SR L LI
: |k - @[3 .
fa} P 3
i h..,:.__:;
Wrckee
Alam
Print.
TPTE0-T L Pork:Thingst FC Senes Deowniond Post:Thingst W Series 0 23,1 5 MM
Way B
L Right-click “screen” in the project manager
IL Then click “Insert” in the pop up menu.
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I

IL

Right-click Screen

2) The new “Screen” dialog box pops up as shown below. Input screen’s ID and screen name and then

click “OK” to finish the creature.

Mame {S creend

Meszage

Cancel

. Creating new windows

1) There are also two ways in creating windows:

Click “window” in the project manager to make it turn to highlight color.

Click (= in the operate toolbar.
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I3 TewchWin Edii Tosl F'|-:-_|-:-.-r Socroenl
Flz Edt View Port Tool Window Help

Ded 2 7 AL TGO EEE T T B @ Faoed oo
\ﬂ.ncooanﬂh Reo¢ #  “EBF=H@GY B Lk -EHE & =
| | © 1o *@ll!\‘:ﬂv"v'ﬁ":"rﬁ

Way B

Right-click “window” in the project manager and then click “Insert” in the pop up menu.

=l ﬁ' Project

Right-click window

32



Software Parts

2) There will pop out a new window dialog box, set the window ID and its name, size and then click “OK”
to finish the creature.

Window

(b Width 160
Hame W inido ] Height 120

Mezzane

ok, Cancel

2-2-1-2 Title setting for a screen or a window
1) While creating a project screen (window), We often give each screen (window) a different name to

identify the screen (window). There are two ways to modify their names.

Right-click a screen or window in the project manager, then choose “Property” in its pull down

menu.

=
= ﬁ- Praoject
= j SCreen
Cuk
Copy
Delete

Properky

Select the special screen and the click in the operate toolbox directly
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5 TeuchWin Edil Tosl F'|.:.-]r--: i - Scroenl

Fia Edt View Port Tool Window Help

DFd | " T AGLATGOM EENE TR @a @ @20 20
NN OocCoowDHE K ROd  “OF=FE9 B Lk -HE &=

pEds g @i S - VY Q@K TED

Pop property of soresn o wandow or othes TETel-T PLC Port: Thinget FC Saries Diowriload Port: Thingst XC Serds ol e )

2) “Screen” dialog box appears as shown below:

E.g: you can type “Front Screen” instead
of “Screenl”

Ok, Cancel |
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3) The modification of window property is similar with screen property (as shown below):

Window [$_<|

1D width |10

Hame  [window Height  [120

Revisable

Meszage |

E.g.: you can type

“Prompt”
(] Cancel
2-2-1-3 Cut/Copy of screens or windows
There are two ways to do cut/copy for the created screens or windows.
L Right-click a special screen/window in the project manager and then choose cut/copy in the pull
down menu.
1 X
= ﬁ- Project
[=] E] acreen
al! Alarm
_-‘} Brink Delete
Property
1L Right-click Screen/Window, choose “Paste” in the pull down menu.
=
= ﬁ' Project
= ]
i 5S¢ Insert

il ] wind
Gl | Alarmn
il | Print
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Click the screen or window in the project manager, then click “ & /<« B .Also, from Edit>Cut

or Edit>Copy, this operation can be realized.

2! TouchWin Edit Tool - Project - Screent
File Edit Wiew Part Tool Window Help

DEH@BRF 2 |AGi E

xﬁDDDDQIE lig il €
(})H]I]% v(—I—J

Right-click Screen/Window, and then choose “Paste” in the pull down menu.
S 4

= ﬁ- F‘rn:n]ect

i Inserk
g )

) .ﬁ.larm

2-2-1-4 Delete screens or windows

Also, there are two ways.

L.Right-click the screen or window needed delete.
II.Choose “Delete” in the pull down menu.
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%! TouchWin Edit Tool - Project - Screen?

File Edit  Wiew Part  Tool 'l.l'l.l'll'lljtlw Help

DEHE & 287 AAAEA ¥
\ = E e t:? @ l = Y |*=ﬁ1
|G Bl e [ el 1I]I]% e C

= @- Praject - Screen?

= . Screen e

Screenl P oo

I.Click the screen or window needed delete.

IL.Click x in the Operate Toolbar.

4! TouchWin Edit Tool - Project - Screen?

File Edit “iew Part Taool Window Help

O= | 2 zllAai W © P = T“Eﬁ'23aﬂ_1;f
RHDDDDQIE&F*;I@ﬁ s '

Z.— ﬁ- Project

=) . Sn:reen

SI:rEEI-Il R BOEEENR SoMEME Siniin poEiDm BN SOnlE P SR BN Bim
1"’! b Do S Done B0l B Donn Somm Dol Bl B0
) window i SR BheE BEE Tl BRI PRl ST RREE BEE B

Gl alarm
Y Print
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38

2-2-2 Downloading Data

After editing, connect 9-pin RS-232 port of PC and TP download 9-pin port with download cables. Then

confirm that TP has been powered with +24V DC. Click@ | or from File>Download Data to download

data. There will pop out a download window to Prompt download process.

Downloading...

If “Time out, check table please” appear ,please re-download

Make sure that TP series touch screen can not be powered off while downloading screen data.

When the transmission finished, a pop-up dialog box will appear to show all the project screens have been

Drawnload finizh |

transferred.

Cut off the power supply of display. Then pull out the cable TP-SYS-CABO and connect PLC and the PLC
port in TP with communication cable.

Electrify PLC and the display, then you can do data monitoring and other operations under normal
communication. Pay attention that incorrect communication parameters and connection can lead to failed
communication and there will appear such words “communicating” ,which show that TP is communicating
with PLC.

If TP and PLC can not communicate normally, please check following items:

1) PLC model in project should be selected according to the operating one.
2) Communication Cable should be connected.

3) Communication Cable should be connected in the right way.

4) PLC Communication parameters should be set correctly.

5) PLC and display should be electrified.

6)If you still can not find the reason, please contact with suppliers to get help.
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3 INTRODUCING MENU

This chapter introduces contents of menu and how to use them.

3-1. File

The function options in the pull down menu of File are used for managing and dealing with the whole

project, as shown below:

%! TouchWin Edit Tool - Project - Screen

F=8 Edit  Wiew Part Tool Window Help

Ty CErl+r f@ A ﬁ ﬁ @. %‘ @
CpeEn... Chrl+ 0 1 z - -
Close e+ - E [:3 ARERE
Save Chrl+5

Save ds,., Chrl+A

Dawwnload Chrl+D

RunCnline(B)  Ckrl+E
RunCFFLinedt)  Ckrl+M

Setting. .. Chrl4+T

Gensoftware

Exit

1) New
It is used for creating a new project, please refer to chapter 2-1 for step introductions.

Also, you can click new icon O to finish the same operation.

2) Open
It is used for opening a saved project which type is  “*.twp” , Also, you can click & After clicking ,a

pop-up dialog box will appear. Choose the project you want to open and then double click its icon, or just

click the icon and then click “Open”.
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Look in: | G New Folder ~] « ek B~

5 TWin V2, 75070928

E offline

g offline, online
E ko ports

File name: ]u:uffline,cunline
Files of type: | Project File[* twp) ] Cancel

3) Close
It is used for closing “TouchWin edit tool” software. If you have not saved the updated project, when you
choose “Close”, the following window will pop out.

File Save

.\:.i) Project hasn't saved vet, Saver

[e] Cancel ]

If you want to save this project, please click “Yes”; if not, please click “No”. Then, you’ll quit this project.

4) Save
If the project you want to save is a new one, “Save” dialog box will pop out, please type your project name,
then click Save to confirm. After this operation, it will save the new project instead of the old project

automatically. = has the same function.

When editing the active present project, please click “save” continuously to avoid losing you project .It’s
dialog box is shown below.
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Save in: ]@' Desktop ﬂ 4= I.jg Ea-

l j My Compuker
I‘r_j My MNebwork Places
G Mew Folder

File name: |F'r-:uieu:t
Sawve as type: IT:::uu:hWinF'ru:uieu:t File[* bwp] j Cancel

5) Save as

It is different from “Save”, “Save” means save active project with its current project name; while, “Save
as” means save the modified project with a new name and do not rebuild the old project. After choosing
this option, “save” dialog box will appear ,then type your project name and click “save” to quit.

6) Download

It is used for downloading data in TouchWin edit tool software to TP touch screen, Click 2 can finish
the same operation. To get more particular information, please refer to chapter2-2-2.

7) Simulate on line

It is used for realizing simulation on line. Choose this option, you can simulate TP action in TocuchWin

a

Edit Tool after connecting PLC and computer. Click the icon : , can finish the same operation.

8) Simulate off line

It is used for realizing simulation off line. Without connecting computer and PLC, or downloading screen

data to TP, you can simulate TP action in the software. Click the icon ‘B can finish the same operation.

9) Setting... (For system)

b EN1Y

It is used for setting or modifying the main parameters and other items, such as “parameter”, “alternation”,

LI

“clock”, “panel” , “device”, “color” , “font” , “project”. The following will describe them one by one.
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Parameter Project Set ﬁ

X
Color ] Faont ] Project ]
Fara ] Alkernation ] Clock, ] Fanel ] Device ]
[~ Screen 1
Start Screen Mo, |1
[ Pazzowrd

Level | - Pazzword |0

~ Screen Save

Latency Time After 3 Minute

(+ [Cloge LCD ™ Show Screen

()4 | Cancel

As shown above, parameter set is divided into three items: “Screen”, “Password” and “Screen Save”.

= Screen

It is used for setting the start screen, namely the first screen after TP electrified. Generally, we set this

screen as the main menu or the most used screen, it is set by screen No.
] Password

»  To improve the safety of machines, the data in TP series touch screen can only be modified by special
personnel. Therefore, TP touch screen can help user protect data more efficiently.

»  Password has three grades: common, advance and system. Common password can only carry out
functions with itself, advance password can carry out function with “advance” and “common”, and system

password can carry out all the password operation.

»  There passwords usually for hiding or encrypting the parts or screens. Only type right password, you
can open or do the relevant operation.
»  The “password” input box showing above is for common one, if you want to enter advance and

Advance
system grades, please click and type password as shown below:
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= Screen Save

Password

Advance | 0

System ] ]

ok Cancel

This function operate automatically when touch screen has not been sprung for a long time. When it arrives

the setting time, touch screen will close the black lamp or jump to the assigned screen, you can only choose

one from the two operations. You can set “latency time” as well as canceling “screen save”. When you

click “shown screen”, you can type screen number in the blank box to assign screen which you want the TP

jump to.

Alternation

Project Set

Color ] Faont ]

Para Alternation l Clack ] Panel ] Device

¥ Change Screen Control
Station

Device  |PLC Port ~

WirStamic Station 1

~Ohiject
Ohiect |D L“ ]
| Indirect

~Iv Report Current Screen 10
Station -

Device  |PLC Port

WirStamio Station 1

-Dhiject
Obiect  |p Bl 0
[ Indirect

|
|

]S | Cancel |

&3

= “Change Screen Control: PLC can switch screen by modifying the register’s value. After ticking it,
choose the suitable “Device” (PLC port or Download port), “Station” and “Object”.
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“Object” is used to set register of PLC which assign the screen number, as shown above ,the object is
DO ,it means that screen number is determined by the value in DO of PLC

= “Report Current Screen ID”: input current screen No. into certain register and transfer the status of panel
to PLC

= Pay attention to that there is an “Indirect” box behind “object”, it is similar with the function of indirect
addressing. After ticking it , you can see the following change.

~Ohject - 1 Ohject
Obiect  |D || 0 :D Obfect D || o
I Indirect

Click DO to open the following window.

Indirect Object

@ oo |

-Station -

Device  |PLC Port 'l
YWirStario Station ] 1

Ohject

Obiect  |p Eall 10
I Indirect

Data

Data viord - |
k. | Cancel ‘ Apply J

Indirect Object

Object
Timesz

r Object Format -
& Dec
i Hew
" Float
™ Unsigned

k. | Cancel

“Object” is used for save address offset, as shown in the above figure, set “5”(decimal) in D10,it means
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current screen ID is saved in D(0+D(10)),namely saved in D(0+5)=D5.In “Data” box ,you can choose
Word of Dword (double word).

In “Data” dialog box ,you can choose data format from “Dec”, “Hex”, “Float” and “Unsigned”. Also ,you
can set “Times”, if still set “5” in D10, “3” in “Times” box, it means that the address stored is
D(0+3*D(10))=D15.

Clock Project Set
Color ] Fant 1 Project ]
Para ] Alternation Clack l Fanel 1 Device ]
v Lse RTC
Station

Device  |PLC Port -
WirStaro Station 1

Ohject
Obiect D Eal 11
| Indirect

k. | Cancel

TP series touch screen set clock inside, as shown above, this function can educe and save the current time.

Tick “Use RTC”, set device, station and particular address in the device. As shown in the above figure,
storage current time in D11 of the device with PLC port, station NO. 1

The function of “Indirect” is as same as described in P46.This manual will not introduce this function in the
following chapters, please refer to P45 for detail introductions.
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Panel —
Project Set E|
Colar ] Fant 1 Project ]
Para ] Alternation 1 Clock, Fanel 1 Device ]
Model TPARD-T

Dezcrption  BO0YE00, 256 colors

Set parameter ’

] | Cancel

This function mainly describes the touch screen and how to set internal storage space. As shown above, the
current touch screen is TP-A60-T, if you want to change its internal storage space setting, please click “Set
parameter” to open the following window.

About touch screen internal space, please refer to chapter 10 to get particular introductions.
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Device

Project Set

Color

1 Fant

Fara ] Alkernation ] Clock

- PLC Part-
todel

Param

i~ Diavenload Part
b odel

Faram

1

] Fanel

Project
Device

Thinget =C Seriez

13200, 8, Even, 1

1 )

1 Thinget =C Series

19200, 8, Even, 1

[

o]

Cancel

— &

As shown above, this function is to setting PLC port and Download port. When you want to change device

or communication parameters while editing, modify the relevant options in “Device” .
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Project Set

Para I Alternation I Clock, I Fanel I Device I
Colar | Fant i Froject I

Kind Colar

S g mrEEEE
EE NEE B

More...

k. I Cancel

“Color” is used for setting background color, there are 256 kinds of color can be choose in this software.

Please pay attention that once the color is set, it will effect all the project screens, as shown below:

e TewchWin Edil Togl - Preject - Sceend

File [ Yew Pat Tool Window Help

- PP AGA DGO mEE P T Y @380 & Hoee o0
4 ®

"o COwOBH L REY % “DT=S0EY B L@
= servenl

M Sciennd
“ermenl o
D scaied M Screend

TP7E0-T JPLC Powk: Thireget WZ Senies Dxcmaradoand Pork: Tharegel BC Serwes o€ BT 0 MM
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Font Project Set [Z|
FPara ] Alternation ] Clock, ] Fanel ] Device ]
Colar Fant l Project j
i~ Demo-

String

k. Cancel

“Font” is used for setting words in the project screen. click “setting...”to open Font window as shown

below:

7K

Eant: Font style:
icrozoft S anz Serif Freqular =
Wicrozoft Sans Serf |._|: l l
T MingLill | talie ance |
todern Bold
(} Monatype Corsiva . |Bold Italic
T M5 Gothic
B M5 Mincho
T M5 Phiothic v
- Effects - [~ Sample
[T Shikeout [
[T Underline AaBhviz
Color: L

1- Black __v_] Script:
]'W'estern _:_J

You can set font, font style, size, effects, color, sample, script and so on. These functions will be introduced

particularly in the next chapter.
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Project Project Set
FPara ] Alkernation ] Clock, Fanel ] Device ]
Colar 1 Fort Fraject
Hame
Avthor |
Bemark

()4 | Cancel

As shown above, you can add name, author and remark in “project set” dialog box.

10) Build SCADA
When click “Build SCADA ,there will create some files, Also, a pop-up window will appear to prompt
where to save these files. After editing ,find this folder ,execute “ AutoWin.exe” can realize configuration

function.

11) Last File
If you have open or edited some projects recently, the software can store the names of these projects
automatically to help user find these more convenient. Instead of finding the project’s paths, click their

names can open it to modify.

12) Exit
Different from “Close”, “Exit” means exit from TP edit tool .If you have not save the modified project
before exiting, the software will pop out a window to make sure if you want to save .This operation can

protect you to avoid losing project.
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3-2. Edit

9 ¢

“Edit” menu is used for carrying out operations of components. This menu contains “Cut”, “copy”,

LIS

“paste”, “public unit” and “private unit’.
p p p

2 TouchWin Edit Tool - Project - Scree

File BaE(8 Wiew Part Tool MWindow Help

[ Zut Chrl+ A SA A4
Copy Chrl4+C

Bl
Public Unit

=i f‘ll'l‘ru’j’ﬂtt“

= acreen

E Screenl

1) Cut 113 &IID L2]

Removes the components from the project and places it on the clipboard. To accomplish this, select
component(s), then click cut under the edit menu; you may also right-click the component and then choose

“cut” in its pull-down menu.

2) Copy 3 2
Copy the component(s) to the clipboard. To accomplish it, select component(s), then click “copy” under the

exit menu, you may also right-click then component(s) and then choose “copy” in its pull-down menu.

The differences between “Copy” and “Cut” are that, when cut component(s), it will disappear, while, when

copy component(s), it will still exist.

3) Paste “

Place the contents of the clipboard at the insertion point, it is used to match “Copy” and “Cut”. After
clicking “Copy” and “Cut”, you can click “Paste” to displace or copy the original component(s).

G . .
4) ““a* ”Public unit

It is used for applying a certain component to all the project screens. To accomplish it, click “public unit”
under the edit menu; also, you may right-click on the components and choose “public unit” in its pull-down

menu.

5) Private unit <&

It is only used after a certain component that has been set public. It has the opposite function from “Public
Unit” and it can be used in the current screen only. When use it, select a certain component, click “Private
Unit” under the edit menu; you may also right-click the component and choose “Private Unit” in its
pull-down menu. After accomplishing, this component will be only saved in the current active screen and
deleted in other screens.
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3-3. View

The “View” menu is used for display the toolbars. It contains Standard, Status, Project, Paint, Zoom, Status
Change, Operate, Part, Align, Advance, Advance2, Panel. Among these, Advance and Advance 2 is in grey
color as shown below meaning that they are not sprung. They are available when TouchWin Edit Tool has
advanced function.

In general, the default setting will show all of these components to convenient operations.

%! TouchWin Edit Tool - Projed
Part Windo
Standard
Skakus

Project

Paink b1
Foarm =

Tool

O & |

s
2

b T SR, R G T N . S

Skatus Chanoge
Operate

Part

Align

v Panel
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3-4. Part

1)

The “Part” menu is used for editing components in the screen .It has the function with the Part Toolbar.

[%] TouchWin Edit Tool - Project - Screent

File Edit View BEEES Tool Window Help
0= & Text

Operate
N O Displayw

Inpuk
| Keyboard
=|-¢5} Project Bar
- B Screer  Dynamic Map
Window
Scheme

r ¥ ¥ r ¥r v
T

Function

Tool

v v v v w

Device

Inverter Alrarm Informakion
Picture Display r
Sample Save

Text
There are “Text”, “Dynamic Text” and “Variational Text” supporting various language, font, size, color and
art effect ion.

n Text 113 A »”

Using it, you can type common characters which are usually static ones. Once you type them, they can not

be modified. Refer to chapter 5-1 for particular usage.
BT
. Dynamic Text “ && 7

Display corresponding text to prompt user while data in the assigned register changing. Dynamic text can
support 16 contents of state, corresponding values are 0-15.Refer to chapter 5-2 for particular usage.

By
] Variational Text « A& 7

Allow user set data values and text prompt of the relevant value. There is no restriction of data number.
Refer to chapter 5-2 for particular usage.

2) Operate

It contains “Lamp”, “Bit Button”, “Lamp Button” and “Screen Jump”, all of which are used for operating
coil.

n Lamp 113 @ »”
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Show the switch status in order to match the operation of button. Refer to chapter 5-4 for particular
usage.

] Button “ &

Open/Close a certain operation to control the bit component. Refer to chapter 5-5 for particular usage.

" Lamp Button “ @

Carry out the operations of both lamp and button. Refer to chapter 5-6 for particular usage.

- Screen Jump ¢ s -

Let the current screen jump to a certain screen. Refer to chapter 5-7 for particular usage.

3) Display
It contains “Digital Display”, “Alarm Display” and “Text Display”, all of which are used for reading data

or characters from registers.

. Digital Display “ B ~

Read data from registers and support various digital format, data length and font. Refer to chapter 5-8
for particular usage.
. Alarm Display « H ~
Read digital values from register, and you can set max and min range, If the data in the register over this
range, the reading out value will twinkle to alarm. Refer to chapter 5-9 for particular usage.
. Text Display « B8 ”

Read characters from registers and support multi-words display, without restriction of length. Refer to
chapter 5-10 for particular usage.

4) Input
It contains “Digital Input”, “Text Input” and “Set Data”, all of which are used for typing information into
register(s).

" Digital Input 23~

Input user’s data into assigned register(s). Refer to chapter 5-11 for particular usage.

. Text Input  “ kB »

Input text into assigned register(s).Refer to chapter 5-12 for particular usage.

123
. Set Data “ 17

Similar with Function Button, it can deal with “ 4. —. X <+ "for the data in assigned register(s). Refer
to chapter 5-14 for particular usage.



Software Parts

5) Keyboard

It contains “Digital keyboard”, “ASC” and “User Input”, all of which are used for typing digital or
text .These input components support pop-up keyboard without setting by user.

. Digital Keyboard “ -~

Place keyboard on the screen and support typing digital only. Refer to chapter 5-15 for particular
usage.

voh

" Text Keyboard « 2 7
Place keyboard on the screen and support typing characters only. Refer to chapter 5-15 for particular usage.

«w 1| |»

= User Input

Type a certain value as a key in keyboard. Refer to chapter 5-15 for particular usage.

6) Bar
It contains Vertical Bar and Horizontal Bar, both of which are used for describing use’s data with graphics.
" Vertical Bar  “ 5

Show the value stored in certain registers and display real time changes of values. Refer to chapter 5-18
for particular usage.

“ﬂ»

= Horizontal Bar

Have the similar usage with “Vertical Bar”, the only difference is that it is level.

7) Dynamic Map
. Dynamic Map “ & 7

Show the changing value in the assigned register(s) via map, it is similar with “Dynamic Text”. There
are 16 kinds of map in the software, Also, you can use your own maps. Refer to chapter 5-19 for
particular usage.

8) Window
It contains “Call Window” and “Window Button” which are used for switching screen and window.
" Call Window “ E

Control the pop-up window by a bit component of appointed coil of a register, usually it is sprung under
certain conditions. Refer to chapter 5-20 for particular usage.
=  Window Button

““ D »”
o

Without controlling coil, only press this button can open or close the appointed window.
9) Recipe
It contains “Down Recipe” and “Up Recipe” which are used for realizing recipe functions.
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“ %’ »
Download recipe data from touch screen to PLC. Refer to chapter 5-22 for particular usage.

“ El-»

= Down Recipe

= Up Recipe

Opposite from down recipe, it is used for uploading recipe data form PLC to touch screen. Refer to

chapter 5-23 fro particular usage.

10) Function

It contains “Function” and “Function Field” which are used for carrying out some special functions. These
functions are “Set Coil”, “Reset Coil”, “Reverse Coil”, “Copy Coil”, “Screen Jump”, “Set Data”, “Copy
Register”, “User Input”, “Open Window”, “Close Window”, “Down Recipe”, “Up Recipe”, “Data Block

Transmit”, “Arithmetic” and so on.

] Function “— 7

When you click this function button, touch screen will carry out certain operation(s).One function button

can spring many functions. Refer to chapter 5-24 for particular usage.

7
« Lox o

= Function Field

It is similar with “Function”, however, their spring manner are different as “Function Field” can be

sprung by button, timer, scan and so on. Refer to chapter 5-25 for particular usage.
prung oy

11) Column Map
It used for showing comparison of several data groups by column map containing discrete column map and

continue column map.

“ 1[[.],»

= Discrete Column Map

It is mainly used for comparison of several data groups that addresses are discrete distributed. There is

no limitation of data numbers. Refer to chapter 5-26 for particular usage.

“1[[.],»

It is mainly used for comparison of several data groups that addresses are continuous distributed. Also,

. Continue Column Map

there is no limitation of data numbers. Refer to chapter 5-27 for particular usage.

12) Basic Tool
It contains “Date”, “Clock”, “Buzzer” and “LCD light control” which are used for some assistant functions

such as prompt, alarm and so on.
. Date « 1~

With this function, you can display date on the touch screen. So it may make relevant operational

convenience and can prompt operators.

= Clock “@~
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It is similar with Date as it is used for display time on the touch screen to make relevant operation of

time convenient.

= Buzzer “ &

Spring buzzer by controlling a certain coil or a bit component in a certain register. This function can
carry out alarm and prompt functions. Refer to chapter 6-3 for particular usage.

e

- LCD Light Control “ ##”

Similar with buzzer, it is used for starting light to prompt user while using TP by controlling a certain
coil or a bit component of a register. Refer to chapter 6-4 for particular usage.

13) Device

It contains devices such as “Instrument”, “Valve”, “Pipe”, “Pump”, “Auto Wind”, “Motor” and “Retort”,
which are widely used in industry automatization. These device buttons can be used in graphics software
directly, therefore, the workload can be reduced.

] Instrument “ ”

It is point to dial instrument used for prompting and reading numerical value as voltage meter and
ampere meter. Refer to chapter 6-5 for particular usage.

. Valve “® 7

Its meaning and usage are similar with valves which used in normal industrial control area. Refer to
chapter 6-6 for particular usage.

. Pipe “==
Show the change and flow direction of numerical value by liquid format. Refer to chapter 6-7 for

particular usage.
n Pump 113 E 2»”
It is similar with pump used in normal industrial control area. Refer to chapter 6-8 for particular usage.

] Auto Wind  “ & -

It is similar with Auto Wind used in normal industrial control area. Refer to chapter 6-9 for particular

usage.
. Motor “ ”
It is similar with motor used in normal industrial control area. Refer to chapter 6-10 for particular usage.

] Retort “ 0 -

It is similar with retort used in normal industrial control area. Refer to chapter 6-11 for particular usage.

14) Invert Alarm Information

" “ &7 Invert Alarm Information
It is specially used for invert alarm. With it, you can set max or min value of each alarm information and

57



Software Parts

58

can type alarm contents. Refer to chapter 6-12 for particular usage.

15) Map
It contains “Real Trend Map”, “History Data Map”, “Event Button”, “Display Real Time Event” and

99 ¢

“Display History Event”. They are used for changing or comparing data as well as recording or displaying

alarm event or spring event.

Real Trend Map “ e

Observe and compare sole datum or several data by real trend map.

“12't 2

History Data Map

It can picking sole datum or several data to form history data and then show them with